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import java.util. Random;
class Dice {
private Random random;
public Dice() {
this.random = new Random();
}
public int roll() {
return random.nextInt(6) + 1;

}
}

public class TestDice {
public static void main(String[] args) {
Dice dice1 = new Dice();
dice.roll();
Dice dice2 = new Dice();
dice2.roll();
}
}

association
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import java.util. Random;

class Dice {
pUinC DICG() { estDice ice
} ©re=w l —}% @ Dice
public int roll(Random random) {
return random.nextint(6) + 1; "\ K

} 9/
} @ Random |
public class TestDice { |

public static void main(String[] args) { |

Random random = new Random();

Dice dice1 = new Dice(); @ Random
dice.roll(random);

Dice dice2 = new Dice();

dice2.roll(random); dependency
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o &g (aggregation)
» 7 7i= H=opX| 2 HH|2F 22 dH 7|7t EX[ot=X[2 #&
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ROMNE B & —|X1|._ RO XX =)
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MESICIH MNEtoz =i &

= UMLOM= 222 HA|SIE|] ®H & LIEtH= =0 "=0| &
CrO[Ot=E" 20| 25

o MANef El=

publ!c class HumanBody {
Sﬂ\éﬁgeljfrg:fggay@ens lens) { © HumanBody o © Lens

this.lens = lens;

}
}
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O -_r“éi(composition)

m HIEr =2 dH 7|7t o|EX (5, ©AH A4H7F S AIH
S8 M gl0f%)

o HAXLE M0 HHE HdoiA B H0f| HEeohH
THoj2tn B &

= UMLOM= &ddf 50| £ CHo[or=E" RYOZ &

s AN E

public class HumanBody {
Eyes eyes;

public HumanBody() {
this.eyes = new Eyes();

}
}
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@startuml
class A © :

class B
class C
class D
class E
class F
class G
class H

C -right-> D
A left>B
E*-F
Go-—-H
@enduml

https.//www.planttext.com/
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WebFile.class ted Qe > oFAl [[[| @ =EIAH
FileCopy.class
FileRW.class
Tools.class
O|E2 ZX|Tt Z=2HOo| C|=2H
CIE o2 Fa

DObject.class
Line.class
Rect.class
Circle.class

project/filelO/Tools.class
project/ul/Tools.class

Main.class
GUl.class
EventHandl
Tools.class

class
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A4 AE(java)2lt el T (class)&= =L (directory)2
L0l A £te|
=cfA O|F0| Z0F 5=5t= A= &7| Rl AHE
otLie| SEEEE=ME O 7He| I{7|X|2 &8 7ts
oStLie| I 7|X[= Bt=1 25 A OedE 20 & =k U=
7| X| = jar LY = =S += US
jarIt & Java Archivel| A2 AtHE SEfA TP SS FHA
HIZSH| £l =5 TtE Ti7|X| oHg 4
o|0] Tj7|X|Z ArEoHZEt=

import java.time.LocalDateTime;
import java.util. Date;



o ApHEO| I Z| K|
javaZ A[EE[= Di7|X|E2 7|2 MS TH7|X|
javaxe = 78
time, utile M2 15 7HE
o 7| X[ 2} Seh2 Of
java.lang.Object
java.applet.AudioClip
java.awt.Component.AccessibleAWTComponent

javax.swing.text.html.HTML
javax.imageio.ImageReader

o I7|X] O|F &8 %*t”
S=oHA| B AhrEA B2 = US
X2 2 URLS 71JFE =

Cr=2 Ot (www.dankook.ac.kr)O| Al BF=M™ kr.ac.dankook
o 7| K| AFE HE
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=/ (7HE A
O£ =0 java.time.LlocalDateTime S22 LU java/time
I = javaWtime ZL5 0| LocalDateTime.class2t= O|E2 2
M E
22 E00= s of7|X[of] =& A= CHE S
NAdsE AS

LocalDateTime java It = java/time ZC 0 RUA0{OF &
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AN = I E = classesd| QUL 7HA

java.applet.AudioClip src/java/applet/AudioClip.java
classes/java/applet/AudioClip.class

javax.swing.text.html.HTML src/javax/swing/text/html/HTML java
classes/javax/swing/text/html/HTML.cla
SS

krac.dankook.ace.Dice src/kr/ac/dankook/ace/Dice.java

classes/kr/ac/dankook/ace/Dice.class
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O importE AFESHK| Y= 3%
= I{7|X| 0|21} 24 0|29 HA| ZZHE MZF0{0F &

public class ImportExample {
public static void main(String[] args) {

java.util.Scanner scanner = new java.util.Scanner(System.in);
}

}
O import AF&

w AA BEF0 ArEota= W7|X| BA| & 240 SeiA HEE AR
import java.util. Scanner;
public class ImportExample {
public static void main(String[] args) {
Scanner scanner = new Scanner(System.in);

}
}
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import java.util.Vector;
import java.util. Random;
import java.util. ArrayList;
import java.util. Calendar;
import java.util. Timer;
import java.util. UUID;

o OfZ|X| Lf MH SHAE S HO import
*= S I7|X| Ljo| SefATHS o|0|stH 9| 7| X| <]
aaﬂﬁnw ERg-ize] N E’JtEr

import java.util.”;
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o Tj7|X| 0|20| Ct2X|Qt SajA 0|20| ZCHE?

import java.util.;
import kr.ac.dankook.ace.*;

java.util.Random rand1 = new java.util. Random();
kr.ac.dankook.ace.Random rand2 = new kr.ac.dankook.ace.Random();

O static import
= 2oL 2H0f ZolEl 8§ oLt §H HAESE A
X import 2= AFESHH 2L O|lF= =T

import static java.lang.Math.*;
double r = cos(PI * theta);
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© Rectangle © Circle

length: int center: int
width: int radius: int

area(): int area(): int
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o PlantUMLO|| Al 7| 9
package IHZ|X[O|& {
mfZ7|X|ol Z&T|= A OlF

}

o 7K 2 F2 8%
@startuml
package my.register { my.register)

my.figures\

class Student

ClaSS COUFSG ©Student ©Course

class Enrollment

}

package my.figures {
class Rectangle (©)Enroliment
class Circle

© Circle

}
@enduml
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= |lang
f Home Share View
V]
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KakaoTalk Downloads

video

8 videos
@ OneDrive

= This PC

¥ 3D Objects

[ Desktop
Documents

¥ Downloads

J’) Music

[&] Pictures

E Videos

% Local Disk (C)

. New Volume (D)

¥ Network
269 items

java.base jmod

% % %N
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/
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
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Name

£ Search lang

Date modified

annotation
constant
invoke
module
ref

reflect

runtime

D AbstractMethodError.class
|| AbstractStringBuilder.class

O Appendable.class

O ApplicationShutdownHooks$1.class

O ApplicationShutdownHooks.class

D ArithmeticException.class

0 ArraylndexOutOfBoundsException.class
D ArrayStoreException.class

D AssertionError.class

D AssertionStatusDirectives.class

D AutoCloseable.class

D Boolean.class

D BootstrapMethodError.class

U] Byte$ByteCache.class
D Byte.class

D Character$CharacterCache.class

4 \ 11 CharactardSihsat class

~

~
202144-12 2%
2021-0412 22
2021-04y12 25
2021-04:12 2=
2021-04-12 2=
2021704112 DT
2021-04bh2 o=
2020-09)15 2=
2020-09]15 2%
2020—09|1 5%
2020—09iw 50%
2020-09-15 2%
2020-09'1 5%
2020-09hs o=
2020-09}15 @=
2020-09)15 2%
2020—09|1 593
2020-09.15 2=

12:29
12:29
12:29
12:29
12:29
12:29
12:29
1:51
1:51
1:51
1:51
1:51
1:51
1:51
1:51
1:51
1:51
1:51

Type

File folder
File folder
File folder
File folder
File folder
File folder
File folder
CLASS File
CLASS File
CLASS File
CLASS File
CLASS File
CLASS File
CLASS File
CLASS File
CLASS File
CLASS File
CLASS File

Size

1KB
20 KB
1KB
1KB
3 KB
1KB

S A0| 0]E(

N

UZU-US-15 25
2020-09'1 5%
2020-09hs 2=
2020-09]15 2.2
2020-09915 2=
2020 gA-15 0=
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java.lang

131
1:51
1:51

1

o 7| X[ of =

CLASS File
CLASS File
CLASS File
CLASS File
CLASS File
C1 ASS Fila

—e
S}

[ 1B
o KB
» java.

1KB

\_IJ&B/_J
6 KB
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ELEs

~

&

23)

lang.Boolean
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o import 7|/ ES O[&3dHA SeiAF AFESHICILD
HEAISHH, SefA 2Ho|2 82| B2 (classpath)2 X| ™ &
Z00|AM 2efAE A =

o =29 /X|[(E =) X8
» S BM A2 E X|Hol= &8 271K - (WM 2t AR A Y

ClMEC| & &=Lt
AA" 2 B CLASSPATHO| A El ClHE2|0| A &=L}

Systemn variables

Vanable Valye

asllog Destination=file

CLASSPATH ACh\Program Files (xB6)Java'\JMapViewer-2Z.0UMapViewerjar C\Pr...
ComSpec CAWINDOW S system3Domd, exe

GT k_ﬂﬁcsﬁp.ﬁTH C\P rogram Files |'x3l5:-"- GekSh Mp'-._'f. 12

Javal| &M —classpath& AtEY = ULCL.

CH> java|-classpath CHclasses CHib,.|\library.Rectangle

Al Seil& THO| EXfot= T7|X| CHEEZ| §EE -classpath
.I
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o O Al

package my.figures;
class Rectangle {

.
O Rectanglejavag my/figures/Rectanglejava® A&



O|ZE20IM g4l mf7[X] T=7]

0 EZME AlA
1 o O
= Eclipse->File->New->Java Project->Z =M E - (Don't
create module-info.java)
o I{7[X| lib &g
. IZ=ZHE grc->New->Package->Name: "my.figures”
o I{Z|X] register &
. IZ=ZHME grc->New->Package->Name: "my.register”
o L7\ X| 2-J0| 2t= &l Z1f

v 1= PackageTest
=\ JRE System Library

v e 7| X| S &0 myfigures TH7|
# my.figures X2t my.register I7| X| 7} & QIC},
# my.register



O|ZE20M | T7|X]| Bt=7]

o my.figures I 7| X| 2t0f| S22 Point THE7
= New->Class->Package: my.figures Name: Point

o Point 29| AA =N

package

public class Point {
private double x;
private double y;

public Point(double x, double y) {
this.x = x;
this.,y = y;

}

}
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o my.app 7| X[ 2t S22 MainTest THE7|
= New->Class->Package: my.app Name: MainTest
O MainTestjava 2Id & A4 =7

package my.app;

import my.figures.Circle;  [import 2 A9, )

import my.figures.Point;

. P y .g Calculator Eef{AE

import my.figures.Rectangle; A2317] SBME 7| x|
Zotote detol d2Y 2

public class MainTest { A A2 0| A 2Leqxof g

public static void main(String[] args) {
Point point = new Point(1.0, 1.0);
Rectangle rectangle = new Rectangle(point, 5.0, 6.0);
Circle circle = new Circle(point, 2.5);

}
)
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o JDK I} 7| X|
s KHIOIME DEE SYASS BEZE IjF|X|2 20| ALRXIO|A)
2

= AHHFOIA] X|SSH= I7|X|= CAHO{e| EFE 2t0|E2H2|QF FAL

= JDK HEF If7|X|= XAtHE 1.877HX]| rtjar LFL 0| E=XHALD, O|F
java.basejmod Z=0f| =X}

= java.base (Java SE 15 & JDK 15) (oracle.com)

https://docs.oracle.com/en/java/javase/15/docs/api/java.base/m
odule-summary.html
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O java.lang
= KAtHf language I§ 7| K|
S AtEF Z2J2 U0 B3 72X

AEZ| X3} 6+_¢_, olx =
SajXet ol 1| | &

s ANS2E import & - import 2 22 QI8

O java.util
= AtHt 7 &2[E| I 7[X]
'-ﬁN AlZh HIH, SHAIY St 22 CHet &
X ol
O java.io
& 5’|E': DOUY, Z2H, A3 S0 2E8s g = U
ClE{H/ o[~ XS

O java.awt
= AtHEFGUI 2223 = ?leh A2t AHEO|A M&

O javax.swing
s AfHEGUI Z2O8E S ?let 28 Ti7[X]
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o Xte} APIS| A A HE
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B | B oveniew lava SE15& DK 15) x

S C ® O htpsy//docs.oracle.com/en/javafjavase/15/docs/api/index html 6 G T s -

MODULE PACKAGE CLASS

TREE DEPRECATED INDEX HELP

a SE 15 & JDK 15

. Search X]

Java® Platform, Standard Edition & Java Development Kit
Version 15 API Specification
This document is divided into two sections:

Java SE

The Java Platform, Standard Edition (Java SE) APIs define the core Java platform for general-purpese computing. These APIs are in modules whose names
start with java.

JDK

The Java Development Kit (JDK) APls are specific to the JDK and will not necessarily be available in all implemontations of the Java SE Platform. Theso APTs
are in modules whose names start with jdk.

LR v s o | ot oates|

Module Description

java.base Defines the foundational APTs of the Java SE Platform.

Java.compller Defines the Language Model, Annotation Processing, and Java Compil

Java.datatransfer Defines the AP! for transtorring data between and within applications.

java.desktop Defines the AWT and Swing user interface toolkits, plus APIs for accessibility, audio, imaging, printing, and JavaBeans
Java.Instrument Dafines services that allow agents to instrument programs running on the JVM

Java.logging Defines the Java Logging API.

java.management Defines the Java Management Extensions (JMX) APL

java.management.rmi  Dafinas the RMI connactor for the Java Management Extansions (JMX) Remote API.

Java.naming Defines the Java Naming and Directory Interface (NDI) APL

java.net.nttp Defines the HTTP Client and WebSocket APIs.

Jjava.prefs Defines the Prafarencas AP

Java.rmi Dafinas the Remote Mathod Invocation (RMI) APL

java.scripting Dofines the Scripting API

Java.se Defines the API of the Java SE Platform.

Java.securityjgss Defines the Java binding of the IETF Generic Sscurity Servicas API (GSS-API).

java.security.sasl Defines Java support for the IFTF Simple Authentication and Security Layer (SASL).

java.smartcardio Defines the Java Smart Card O APL

Java,sql Defines the [DBC APL

java.sql.rowset Defines the JDBC RowSet AP

java.transaction.xa Defines an API for supparting distribuled Lmnsactions in JDRC

Java.xml Defines the Java APl for XML Processing (JAXP), the Streaming API for XML (StAX), the Simple API for XML (SAX), and the W3C Document Object
Model (DOM) APT

Java.xml.crypta Defines the API for XML eryptography.

Jdk.accessibility Defines JDK utility classes used by implomentors of Assistive Tochnologies.

jdk.attach Defines the atlach AP

Jdk.charsets Provides charsets that are not in java.base (mostly double byte and IEM charsets).

jdk.compiler Defines the implementation of the system Java compiler and its command line equivalent, javac.




Object S22

javalang I 7| X[Of =gt
AHHE S22 Al & 72| Z {0 ]
D= Sd29 I S
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A= 2%
protected Object clone() o 2|2t £L4E2 HHE S0 2|E
boolean equals(Object obj) obj7t 71217 |= 24H|2f SIXH HA|7t 2| St 22 true 2[EH
Class getClass() S ZHH|o| 2HEIR] S AZ 2|E
int hashCode() A 2ol chHet siAl 2= gt 2[E
String toString() o 2|&

A0 ChEt AED BHS
=

ZHA|0f| CHall CHZ |5t Q= SHtel AHIES THERLH,

rel

void notify()

void notifyAll() W0l CHall CH7 |5t = BE AdEE TR,

rol

N

void wait() = A2E7) JiE W7EK] S A|ES 7 |ofA| St
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o AtEte| 7| = EtlE 2L

=
7= byt hort int 1 h float doub] bool
yte | shor in ong char oa ouble oolean
clolef Efg
Wrapper
Byte Short Integer Long Character Float Double Boolean
2ciA R
oSL
Ol S roy = =
» 7|2 EfRL UE AIEE = Bl AN T ALESHE ZHEM SO
o o
7|2 ErRIC| S

Wrapper Seli& AN = TS0 ALE



o 7|= EtRel 4= 2XE Wrapper 2L 9% 25

Integer i = new Integer(10);
Character ¢ = new Character('c’);
Float f = new Float(3.14);
Boolean b = new Boolean(true);

o HO|H 4= LBt 2AE8s ddXF AAtE ArE

Boolean b = new Boolean(“false”);
Integer | = new Integer(“10”);
Double d = new Double(“3.14”);

O Float= double EfR2| 4= M AXtQ| CIAZE ALE

Float f = new Float((double) 3.14);



T2 HxE

te EOl AtE

HAS

static int bitCount(int 1)

St= Integer 22X

o £9 HAE

29

QX 9] 0|l BRH0M 19| 75 2|E

float floatValue()

float EfRIS

int intValue()

2
int EfQJo = HStE Zf

Tong TongValue()

long EfRIO 2 HSHE It 2|H

short shortValue() short Ef@le 2 HatEl Zf 2|E

static int parseInt(String s) AEEl 5 107 M2 HElE 4 2|E

static int parseInt(String s, int radix) AEE & X|HE XIHO M2 HEE ZF 2|E
static String toBinaryString(int i) CIXHiE O|Zl~ HAOZ HalFE AEEZ] 2|H
static String toHexString(int i) CIXIiE 16Tl o2 HAE AEEZ] 2|H
static String toOctalString(int 1) OIXt 1S 8%l HHOZ HalE| AEZl 2|E
static String toString(int i) OIX} iE AEZIOZ HBI5I0] 2|=



0 Wrapper 24X 285 7|2 HO|& EtQ &OtLY 7]
Float f = new Float(3.14);

Integer i = new Integer(10);
et ger(19) float ff = f.floatValue(); // ff = 3.14

int ii = i.intValue(); // ii = 10

Boolean b = new Boolean(true);
/[ bb = true
boolean bb = b.booleanValue();

o0 2t 7|2 Ho|E Eto R e

int i = Integer.parselnt("123"); // i =123
boolean b = Boolean.parseBoolean("true"); // b = true
float f = Float.parseFloat("3.141592" ); // f = 3.141592

Character ¢ = new Character('c' );
char cc = c.charValue(); // cc = ¢’



o 7|2 OO|H Efis =AtE=E #Het

/| 85 1238 AP "123" o2 et
String s1 = Integer.toString(123);

/| E4 1232 16%I+2| BAMYE "7b"2 B
String s2 = Integer.toHexString(123);

/| == 3.1415928 =Xt "3.141592"=2 Bt
Strlng s3 = Float.toString(3.141592f);

| 2xF'a & =AY "a"2 HE
String s4 = Charater.toString('a’);

/| 28 2k trueE EAIYE "true"= BHE
String s5 = Boolean.toString(true);



OiXl : Wrapper 224 28

Ct=2 Wrapper 22iA~E &&80%t= 0|O|Ct O ZE 189

24

public class WrapperClassEx {
public static void main(String[] args) {
Integer i = new Integer(10);
char c ='4",
Double d = new Double(3.1234566);
System.out.printin(Character.toLowerCase('A'));
if (Character.isDigit(c))
System.out.printin(Character.getNumericValue(c));
System.out.printin(Integer.parselnt("-123"));
System.out.printin(Integer.toBinaryString(28));
System.out.printin(Integer.toHexString(28));
System.out.printin(i.doubleValue());
System.out.printin(d.toString());
System.out.printin(Double.parseDouble("44.13e-6"));




7|2 Epel]

int

10

2= Wrapper 4|2 H2lS
gt (unboxing)
Wrapper 2

AH0 =0 A= 7|= EFRL

di2l (boxing)

Integer ten = new Integer(10);

Y

A

1nt i = ten.intValue():

I_nteger' ZH|

10

~



o JDK 158 H X|&
o Ats 2 (Auto boxing)
= 7|2 EtRYQ S AHS2E Wrapper K| 2 Bt
o Ats AHEFHE(Auto unboxing)
= Wrapper K& X522 7|2 EIY 422

T
i

Integer ten = 10; // AHS 24l 10 -> new Integer(10)2 £ XIS H A
inti=ten;// Xt& 18 Al ten -> ten.getintValue(); £ At 18F A
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[ 2E0| Oigt 2t FHAU7}?

public class AutoBoxingUnBoxing {
public static void main(String[] args) {
inti=10;
Integer intObject = i; // auto boxing
System.out.printin("intObject =" + intObject);

i = intObject + 10; // auto unboxing
System.out.printin("i =" + i);




0o String - java.lang.String
= String 2L = SfLEC| 242 H T
| AER BIEHEHZE AEZ X 4
String str1 = "abcd";

/| String 2eilA 9| H-HXE 0|&5t04 EAt

char[] data = {'a', 'b', 'c', 'd'};
String str2 = new String(data);

O3 AH A4

o O

String str3 = new String("abcd"); // str22} str32 25 "abed" & AFQ

= String ‘48Xt

AKX} 23
String() Hl AE2] ZH| AN
String(char[] value) 22X} 0| =&k AEZ ZhE|E M
String(String original) QX2 X AEE] £ AEE | 4y
String(StringBuffer buffer) AEE HIof Z&HE S AEZ] ZHH|Z MY



A E& 2| E 1} new String()

o
=t EI HHE ¥H, String s = "Hello";
JUMO| 2| 2tz| 2oz 3 oA 29 =
= String M| 2 4, String t = new String("Hello");

C

20l String A4H| -4 Rt 74 717Me] A3 2lEfel Elolz

a @ > "Hello"

String a = "Hello"; /

String b = "Java"; b @ > "avar

String ¢ = "Hello"; »

String d = new String("Hello0");

String e = new String("Java");

String f = new String("Java"); 1e >|HeTie”
e @ > "Java"
f @ > "Java"

g o222



String s = new String("Hello0");

L

s.concat("Java"); // AEZ sof "Java"E HE
e
_ . N | s.concat("Java")2| &
° LU s IV PP
® » "HelloJava"

e
AEZS HWE [ BLEA| equals()E AF23H0{OF &
| =

k7| o



String 22 F2 HAE

|]-||AI:

pul B

char charAt(int index)

23

KX[EEl index QUHIAL]| U= ZAF AL 2

rm

int codePointAt(int index)

AN
X[ EE index QHA0| U= RUZE 2t 2|H

int compareTo(String anotherString)

£ AEYS AEH &MS 7IFO2 Hm, F AER0| 2o
0 0, & AEZ0| X|HE AEZHC} APHKOZ HA| LIQH
==, Ol U5 2|

String concat(String str)

boolean contains(CharSequence s)

int Tength()

String replace(Charsequece target,
Charsequence replacement)

target0| X|&EGl= 20| 2XF=Z= replacement7} X|&5H=

SxIS2 BT A alE

String[] split(String regex)

HTA| regex0fl YK|GHs 222 FMoR AEUS Halsin

22| AEES UGl MESH 2|8

String subString(int beginIndex) beginIndex QIHIALEE] A|EGH= ME AEZ 2|H
String tolLowerCase() AEZS ARKIZ HASH AEE 2|H

String toUpperCase() AEZS W22 HASH AEZ 2|H

String trim() AEZ YFO| Zu EXES M|7A{st AEE 2|H



=XI€ H|i

O int compareTo(String anotherString)
« 2Xtg0| Zop o 2[H
= O] EX}<Z 0| anotherString 2Lt A0 HA LIQH S 2|H
o gi ZAFE 0| anotherString ECH AFHO| LSO LI =
String a = "java";
String b = "jasa";
int res = a.compareTo(b); , ,
f(res == 0) P (b) "java" 7} "jasa" ECt AFH O Lt
= | Ok A
System.out.printin("the same"); SO L2l Mo = 2
else if(res < 0)
System.out.printin(a +"<"+b);
else
System.out.printin(a +">"+Db);

java>jasa
o HI HMX == EXIE HW= ALSE

A HO
T HA O



5SS 2RHY M

System.out.print("abcd" + 1 + true + 3.13e-2 + 'E'+ "fgh" );
// abcd1true0.0313Efgh &=

o String concat(String st O| 2%t 2AIE G &
"abcd".concat("efgh");
// “abcdefg” 2|E
7|E String N0 AAE[X| 0 MERZ AET A Ad
| &=



concat()= MEE2 =Xl€= MM

String s1 = "abcd";

| s1 = s1.concat(s2);
String s2 = "efgh";

1 [ abcd 1 -X\ abcd
- abcdefgh

S2 efgh

S2 ' efgh



=XAE el S HA, =XEL 4 =X B

o &2 XA
= String trim()
=X o F SH EXftab, enter, space) M ATt =AtE 2| E

String a =" abcd def ";
String b = "\txyz\t";
String ¢ = a.trim(); // ¢ = "abcddef"
String d = b.trim(); // d = "xyz"

O —'—X|' E— Tl?:ﬂ'

= char charAt(int index)
=AE Wl =Xt H2

// "class"0l| L El ‘s’ I+ E M= ZE
int count = 0;

String a = "class";

// a.length()= 5

String a = "class"; for(int i=0; i<a.length(); i++) {
char ¢ = a.charAt(2); //c ="a' if(a.charAt(i) =='s")
count++;
}

System.out.printin(count); // 2 &7



O|X| : String el HAE &

public class StringEx {
public static void main(String[] args) {

String a = new String(" abcd");
String b = new String(",efg");
Il 2Xtd 44
a = a.concat(b);
System.out.printin(a);
/| S5 &7
a = a.trim();
System.out.printin(a);
Il 2XtQ CHX|
a = a.replace("ab","12");
System.out.printin(a);



O| | : String 22 HAE &

Il 2XtE 2L
String s[] = a.split(",");
for (int i=0; i<s.length; i++)
System.out.printin("E2[E! " + i+ "H EXILG: " + gJi]);

/I e AE-

a = a.substring(3);
System.out.printin(a);

Il =AtLEo| 2 At
char ¢ = a.charAt(2);
System.out.printin(c);




Of H| &< 1p7g

a = new String(" abcd"); a
b = new String(",efg"); b
a = a.concat(b); a
a = a.trim(); a
a = a.replace("ab", "12"); a
String s[] = a.split(","); s[0]

s[1]
a = a.substring(3); a
char ¢ = a.charAt(2); a

@ e
@ >
@ =
@ >
@ >
@ >
@ >
@ >
@ =
=] -




StringBuffer Sl

O java.lang.StringBuffer

AEGD 2| 4H S

= append@} insert

= StringBuffer 242

o MKt

StringBuffer sb = new StringBuffer("java");

A aX} a3
StringBuffer() 7| HIMC| 27|7} 1621 AEH HIy ZHx| 2HiH
StringBuffer(charSequence seq) seq’} X|&5l= =0 2X5S Zelel= AEZI HIH AHM
StringBuffer(int capacity) XEE =71 37|18 4= AEE HiH M4
StringBuffer(String str) X &= AEZIOR 7|51 AEZ HIH MA




SringBuffer =8 HAE

StringBuffer append(String str)

str AESZ AEZ] HIHO| ZHEQICE,

StringBuffer append
(StringBuffer sh)

sb AE2] H{HES FAfo| AE2! HHo| SHZQICt 0f 2t Bixf A
£2] H{Ho| LIR0| it

I'

int capacity()

oM AE HIHe| 27| 2|H

StringBuffer delete
(int start, int end)

start 2|X|0i|l A end7t X|EH5t= 22Xt AWK AEZ K|

StringBuffer insert
(int offset, String str)

str AEZIS AEZ HIHO| offset YX|0]] AR

StringBuffer replace
(int start, int end, String str)

AER B LHQ| start7} XIFSt= SXHFE end?} X|Fok= 22Xt
Aol ME AEZS str2 X

StringBuffer reverse()

AEE HIY o] X5 B =M= ¥

void setlLength(int newLength)

i

2l HIH L 2X}E Z0|Z newLength2 AHAH X Z0|LCt
AL 49 2X2 AR A2 A= 7|1E 2AKE0| A2t

ru




StringBuffer?| H|&AE

=}
=

g 0

StringBuffer sb = new StringBuffer("a");

sb.append(" pencil");

sb.insert(2, "nice ");

sb.replace(2, 6, "bad");

sb.delete(0, 2);

sh.reverse();

int n = sh.length();

char ¢ = sb.charAt(3);

sh

sh

sh

sh

® > a

[ ] > 4 p|e
® > a n| i

[ > a b | a

ol A UJ[EIEA&EJ

[ > b | a d

® » 1| 1| c|n
® » 1| 1| c|n

=
A




O H| : StringBuffer 22| HAE E&

StringBuffer S eiA9| H|A~EF O|8510 EAE8& Z=&St= O & EO[A}

thS RO MY HIpeo

public class StringBufferEx {

public static void main(String[] args) {
StringBuffer sb = new StringBuffer("This");
System.out.printin(sb.hashCode());
sb.append(" is pencil"); // Xt Si£0|7|
System.out.printin(sb);
sb.insert(7, " my"); // EXIYE 4
System.out.printin(sb);
sb.replace(8, 10, "your"); // Xt CHx|
System.out.printin(sb);
sb.setLength(5); // 2E 2 HI{ L} X} Zo| MK
System.out.printin(sb);
System.out.printin(sb.hashCode());




StringTokenizer S22

O java.util.StringTokenizer
» 2 EAE 7 ELE EAE 22
A E S A2 I AM8 k= 2AtE #& =AHdelimiter)2t1 g

String query = "name=kitae&addr=seoul&age=21",
StringTokenizer st = new StringTokenizer(query, "&");

= 2o OO M ‘&7t 2 =AF

= EZ(token)
T2 2AE 222 2Kt
0|

(@
=
= String 2229 split() HIAEE 0|83 5

o

= Its



StringTokenizer =82 A E

o StringTokenizer 4 Xt

StringTokenizer(String str) str AEZIOZ IIAISE AEZ] ETL 10| AN

StringTokenizer(String str, String

. str AEZI0} delim L2 2AL2 DHAISEAEZ] ETLI0 A AN
delim)

str AEE} delim 12 2XI2 OfAlet AEZI EFLI0|A AH
A returnDelims7} trueO|™ delim0| E&I=l 2XtE E20]| &
SHEIC

StringTokenizer(String str, String
delim, boolean returnDelims)

int countTokens () AEZ EFLIO|X0f| ZEHEl E29] JH4 2[E
boolean hasMoreTokens () AEZ ELI0|IX0| CHE E20] RI2H true 2|H

String nextToken() [ B2 2E




StringTokenizer ~Z

A

o

834 =xE =1

String query = "name=kitae&addr=seoul&age=21";
StringTokenizer st = new StringTokenizer(query, "&");

StringTokenizer st = new StringTokenizer(query, "&");

st @ > "name=ki tae" EZ1
"addr=seoul" EZ32
"age=21" EZ3
StringTokenizer ZHX||
st ® > "name" E31
"kitae" EZ2
"addr" EZ3
"seoul " EZ24
"age" EZ5
"21" EZ6

StringTokenizer ZHx|



O H| : StringTokenizer 224 HAE &
=

'SEE/S=/SH/ESF/EF"ENES/E 7= A= Ot
EZs 220t &4 EE2E SHdtet

import java.util.StringTokenizer;

public class StringTokenizerEx {
public static void main(String[] args) {
StringTokenizer st =
new StringTokenizer("& &2 &/&s/SH/ISFIEF", "I");
while (st.hasMoreTokens())
System.out.printin(st.nextToken());

}
}




Math S

0 712EQ At QMG S¥sHE BAL H D

—_ L
= java.lang.Math
» BE HAEE staticRE MA
s Sdi£ O|ZC% HiZE = Jt5

|)~.=

static double abs(double a)

23

o Aoyt 2lH

[=7]

static double cos(double a)

a| cosine Zf 2|&

ae| sine 4f 2|=

static double tan(double a)

w | nz | x|
4 4| |

a°| tangent Zt 2|&

(
(
static double sin(double a)
(
(

static double exp(double a) e Zt 2|Ed

static double ceil(double a) iéiifé“ Ze 4 B0IM 718 =2 Has
static double max(double a, double b) S 443 bs0M E 5 2EH

static double min(double a, double b) 54 a bBOM A2 £ 2[E

static double random() 0.02CH 37{L} Zk11 1.0ECF &2 2l0|o| Al4 2|H

static double rint(double a)

static long round(double a)

RIFE A4 a0l 71 23 48 A4 ElQIoR 2|H
X

static double sqrt(double a)

as A% ZM Xj2|of M PHESEIB FH4E Tong EHY



Math Sci|£ S 8% o+ B

A H
O Iil'—l‘ El-gl

= static double random()
0.0 O] 1.0 O|2t2| ¥ 2|9f double atS Bret
00| A 100At0|2] H== 't 107 Al7|=
for(int x=0; x<10; x++) {
double d = Math.random()*100; // [0.0 ~ 99.9999] &l di 4
/| dE B2 RSt M2 Bdgk [0~100] AbO[Q| M
int n = (int)(Math.round(d));
System.out.printin(n);

}
2|0 IEO|M round() HAE+= Math. round(55.3)2 55.02
2| E1SHH, Math. round(55.9)= 56.02 2| &

= java.util.lRandom S2{AE O|835tH & O CtYSt HEFE L=
HFAH 7|_i
= O o



O X : Math E22i|A AL =&

Math SciA9| CHYot HaE &

public class MathEXx {

public static void main(String[] args) {
double a = -2.78987434;
/1 8ozt st 7|
System.out.printin(Math.abs(a));
System.out.printin(Math.ceil(a)); // ceil
System.out.printin(Math.floor(a)); // floor
System.out.printin(Math.sqrt(9.0)); // A& 2
System.out.printin(Math.exp(1.5)); // exp
System.out.printin(Math.rint(3.141592)); // rint
/1 [1,45] AO| Q| ih== B A4
System.out.print("O|HF 29|
for (int i=0; i<3; i++)

System.out.print(Math.round(1 + Math.random() * 44) + " ");

System.out.printin(" & L|C}.");

fok

=");




Calendar A

O Calendar

=29 ST

= java.util 7| X|
0 )\|7}‘||- L—FN x—lE _T'_|-E|
L;I, oJ OI _Q_OI All_’ E,

Calendar

o - =
= —=

e

YEAR

A0l 2t AJZH Q4

20|

He

DAY

MONTH

i
=

DAY OF WEEK

HOUR

O~11A|Z= E3BE A

M

AM PM

HOUR OF DAY

2 INFA =SS I N

MINUTE

SECOND

&=

MILLISECOND




Calendar Z4X| 48 % SR AlZh

o Calendar 24| /g
= Calendar now = Calendar.getinstance(); 0| &
nowZiM= SXlf IRt A2 HEE 7HX[ 2 dd
Calendare & 2220|222 new Calendar() SHA| &
o SX§ =R A|ZE
int year = now.get(Calendar.YEAR);  // X AT
int month = now.get(Calendar. MONTH) + 1; // T4 A &
o =& AlZE 251
w L7} 22| IReb AlZHS CalendariX| & O] &30 A&
Calendar A0 FWe} AZHS H7ETCHD S AFEH IRt AlZES
HH = A2 Ot -> ARHL| A[Zta} ERE Y = CHE W O[&
/| O'd EIFet MZ 22 C|0|EEF EMet Al7h KM%
Calendar firstDate = Calendar.getinstance();
firstDate.clear(); // T et A7 HEE 25 X|=2LCF.
firstDate.set(2012, 11, 25); // 20123 12& 252, 12862 M2 &A™
firstDate.set(Calendar. HOUR_OF_DAY, 20); // X9 8A|IZ MH
firstDate.set(Calendar.MINUTE, 30); // 30E2Z M™



Of| &l : CalendarS O|£6}0] HX| LM} A|ZFH
EE=I 5't| A-Ix-|°|_7|

import java.util.Calendar;

public class CalendarEx {
public static void printCalendar(String msg, Calendar cal) {

int year = cal. get(CaIendar YEAR);
/I get()2 0~3077}X|o| H== 2|E.
int month = cal.get(Calendar. MONTH) + 1;
int day = cal.get(Calendar.DAY_OF_MONTH);
int dayOfWeek = cal.get(Calendar.DAY_OF_WEEK);
int hour = cal.get(Calendar.HOUR);
int hourOfDay = cal.get(Calendar.HOUR_OF_DAY);
int ampm = cal.get(Calendar. AM_PM);
int minute = cal.get(Calendar.MINUTE);
int second = cal.get(Calendar.SECOND);
int millisecond = cal.get(Calendar.MILLISECOND);
System.out.print(msg + year + "/" + month + "/" + day + "/");



Of| &l : CalendarS O|£6}0] HX| LM} A|ZFH
EE=I 5't| A-Ix-|°|_7|

switch(dayOfWeek) {
case Calendar.SUNDAY : System.out.print("& 2 &"); break;
case Calendar.MONDAY : System.out.print("2 2 &"); break;
case Calendar. TUESDAY : System.out.print(" 2 &"); break;
case Calendar. WEDNESDAY : System.out.print("s= 2 &"); break;
case Calendar. THURSDAY : System.out.print("= 2 &"); break;
case Calendar.FRIDAY: System.out.print("= 2 &"); break;
case Calendar.SATURDAY : System.out.print("E 2 &"); break;

}

System.out.print("(" + hourOfDay + "A[)");

if(@ampm == Calendar. AM) System.out.print("27");

else System.out.print("2F");

System.out.printin(hour + "A| " + minute +
+ millisecond +"Z2|Z=");

"H "+ second + "X ¢



of| H| : CalendarS O|238}0{ S| M} A|Zt
EE:I 3<| A'lx-lol_jl

public static void main(String[] args) {
Calendar now = Calendar.getlnstance();
printCalendar("$31& ", now);

Calendar firstDate = Calendar.getlinstance();
firstDate.clear();
12012\ 128 25, 128 S E#57] /3 monthofl 112 A7
firstDate.set(2012, 11, 25);
firstDate.set(Calendar. HOUR_OF_DAY, 20); // X' 8 A|
firstDate.set(Calendar.MINUTE, 30); // 30&=
printCalendar("*{& Cl|O|E&t 'E2 ", firstDate);
}

}




0 Java 9 Module System
Project Jigsaw
Modular JDK
Modular Java Source Code
Modular Run-time Images
Encapsulate Java Internal APIs
Java Platform Module System
Hold 2580 Java S 8= BHE7] RISHAM Al
Jar 7|8F R 2|E] YA S M50 HE X Bl EEE HE 2
’ls 7t
g2act Bt #3010 37|25 ZH=t 7t
HICIE 2tE0f ] ot 50 gL 32 {22z 2T
’ts



0 Java 9 B &
I 7| X| &2 FHAM Fa2A|A 22|e = QU= A
C

7|X|= 23 A= SdL5S FOAM &

0x
o
1o
Q

OtOl| M private, protected, public 2| 7FA|/S
of7|X| & E= QB AM ArESE = /U= SEAE 1Y
Faotot HEst &
o 7| X|e] £/40| 29| F4&ziLt HH=stE Xl 27t
HFAH &F
= O
0d|: sun.misc.BASE64Encoderlt sun.misc.BASE64Decoder S22
DE2 UREHCo=E AZSt 1 2= 17| X| =2] public
S A2 S0| R5FO|A SEl= A2 U2 = US
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module-info.java

0 BE2 module-info.java Tt Q0] Otz 37tX| &
MASH= AT EQ0{XQl The

module name

exports

requires

module com.mycompany { // W 2& 0|&
exports com.mycompany; // com.mycompany A< = AZ

requires com.yourcompany; // com.yourcompany At2g A



module name

module-info.java

exports
O module-infojava _
|: = requires
= Module name (Z& 0| &)
DEO|E2 =2 ulst7| Ish TH7|X| BH &1 FA

S 1|3}
= Export (O™ Zie N Sdt=71?)
Y Z=0| CHE 9 F =0 AIBE = JIEE 371 APIEZ
U= BE 7K SE2 MS

/1 /| =
Jrok O Z e A7t publicO|2t & X| 2t export=l TH7|X|0f Gl ™
25 2F°o o A O] a0 M2 27ts

= Require (0| AS0| HRTHII?)
sie 21 o|E AV Y= LHE B8 =

ru|o
oL
=



D= ol "

o 2= 4+ 2

= module-infojavaE sl of &t

= com.my.app.moduledA= 08 232 ArELE X[ X[H
= com.my.hello.module0| A= O T{7[X|ZE M5 AKX X[H

2 =: com.my.app.module 2 =: com.my.hello.module

1§ 7| X|: com.my.app I§ 7| X|: com.my.hello

com.my.app\ com.my.hello\

requires exports
@) wain Rl s e iy = | @Hello
toWhom: String

@ Hello()
@ Hello(String)
o sayHello(): void

o static main(String[])




RE e 3

o ChE E== AM8dle &

= com.my.hello.module2 At&%t

module com.my.app.module {
requires com.my.hello.module;

}

o E=0M 7[s= HSdte &
= com.my.hello Ti7|X| 2| public EELE AtE

module com.my.hello.module {
exports com.my.hello;

}

[=1;
=

A O
4 9zE

oo



D= ol "

package com.my.hello;

public class HelloModule {

String toWhom = "World";

public HelloModule() {

}

public HelloModule(String toWhom) {
this.toWhom = toWhom;

}

public void sayHello() {
System.out.printin("Hello " + toWhom);

}
}



D= ol "

package com.my.app;
import com.my.hello.HelloModule;

public class Main {
public static void main(String[] args) {
HelloModule hm = new HelloModule("Java");
hm.sayHello();

}
}



D= ol "

ModuleAppTest->Build Path->Configure Build Path

Project Tab->Modulepath->Add->Select ModuleHelloTest

& Properties for ModuleAppTest

type filter text

Rescurce

Builders

Coverage

Java Build Path
lava Code Style
Java Compiler
Java Editar
Javadoc Lecation
Project Matures
Project References
Run/Debug Settings
Task Repository
Task Tags
Validation
WikiText

Java Build Path

(2 Source = Projects By Libraries % Order and Export @ Module Dependencies

Required projects on the build path:

v L Modulepath
== ModuleHelloTest

& Classpath

Apply and Close

Add...

Edit...

Remove

Apply

Cancel




